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10 Watershed Characterization Reports 

 

The BASINS system includes tools designed to assist in summarizing key watershed information in a 
format suitable for preparing watershed characterization reports. These tools can be used to make an 
inventory and characterize both point and nonpoint sources at the watershed and subwatershed scales. The 
tools’ functions include generation of customized maps and tables summarizing the overall condition of 
the study area. 

Watershed characterization is key to understanding water quality issues and pollution sources in the 
watershed. In addition to evaluation of the watershed condition, it provides the necessary information to 
assess monitoring programs, identify data gaps, and develop watershed-water quality modeling strategies. 

BASINS version 3.0 provides users the capability to generate six different types of watershed 
characterization reports: 

• Point Source Inventory Report 

• Water Quality Summary Report 

• Toxic Air Emission Report 

• Landuse Distribution Report 

• Landuse Distribution Report (Grid) 

• State Soil Characteristics Report 

• Watershed Topographic Report 

• Watershed Topographic Report (Grid) 

 

The customized maps and tables generated by these reports are stored in a directory called 
\Basins\WcReport\<StudyArea>\Reports\, in which the StudyArea is the user-defined name or identifier 
of the study area. This study area name corresponds to the name in the View Table of Contents given to 
the theme that contains the boundary information of the study area. By default, when a user uses the 8-
digit cataloging unit as the basis for defining the study area (without delineating a new subwatershed 
within the 8-digit cataloging unit), the study area is assigned the name “catalogi” based on the theme 
name Cataloging Unit Boundary in the View Table of Contents. When generating a report for the first 
time, the user is provided the option to select another name to replace the default study area name. 

The files stored in the \Reports directory are of two types text file (*.txt, *.tx1, .tx2) and image file 
(.wmf) which, respectively, contain the tabular and map information about the selected watershed 
characteristic. These files can be directly imported into any standard word processor for further 
formatting and incorporation into other watershed characterization reports. 
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10.1 Point Source Inventory Report 

 
Purpose 

Point Source Inventory Report provides a summary of discharge facilities in a given watershed. The 
report relies on the EPA Permit Compliance System (PCS) database to identify permitted facilities in the 
selected study area and summarizes their discharge loading for a given pollutant. A discharge loading 
summary is provided for a given year. BASINS version 3.0 includes annual point source loading data for 
the period of 1991 to 1999. 

Application 

Point Source Inventory Report is a useful tool for characterizing pollutant loadings in a given watershed.  
Potential applications of this report tool include rapid identification of point sources, a mapping function 
to display the geographical distribution of point sources in the study area, and evaluation of their 
proximity to major streams (streams in Reach File, V1). The inventory and summary of loading 
discharges also allow the user to perform a planning-level assessment of the magnitude and severity of 
point source contributions. Generating this report for various years can provide information to evaluate 
the changes of point sources over time and support trend analysis. 

Before you Get Started 

First, verify that the “Reports without Spatial Analyst” extension is active in your BASINS project by 
typing Ctrl+B from the BASINS view and selecting the Reports item from the Extension Categories 
dropdown list.  The “Reports without Spatial Analyst” entry in the Basins Extensions list should be 
visible and selected.  If the “Reports without Spatial Analyst” is not selected (checked), click on it to 
select it. 

Key Procedures 

• Activate the watershed boundary theme 

• Select the watersheds for which the report will be generated 

• Under the Report main menu, select the Point Sources Inventory Report submenu 

• Select the discharge year, pollutant of interest, and map option in the dialog box 

 

Operation Steps In the BASINS View table of contents (Screen 10.1.1), click the name of the appropriate 
watershed boundary theme to make it active. The watershed boundary theme may be the cataloging Unit 
boundary theme or a user delineated watershed boundary theme.  
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 Screen 10.1.1 

Activate the Select Feature tool and select (by clicking or dragging a box) the watershed(s) for which the 
Point Source Inventory Report will be generated. 

 

Tip: The Select Feature tool allows you to drag a box over a group of features you want to select. 
Features that fall partly or wholly inside the box you define are selected. To select features that 
are not adjacent to one another, hold down the SHIFT key and select as many nonadjacent 
features as you want. By default, selected features are highlighted in yellow on your view.  

 

Under the Report main menu, select the Point Sources Inventory Report submenu. In the dialog that 
appears (Figure 10.1.2), select the discharge year and monitoring (pollutant) parameter from the list boxes 
provided. Click the check box if a location map of point sources is to be generated. You may choose to 
enter the map title in the text box provided.  
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 Screen 10.1.2 

Click to generate the report; otherwise, click Cancel to quit the tool without generating the report. 

 

TUTORIAL:  

Click the theme Cataloging Unit Boundaries to make it active.  

Check its check box to display the boundary theme in the View Window.  

Check the check box of the theme Permit Compliance System to display the location of the PCS stations.  

Using the Select Feature tool, select watershed 05010007. Your BASINS screen should now look like 
Screen 10.1.1. If necessary, zoom to the study area using the Zoom to Selected Theme tool.  

Under the Report main menu, select the Point Sources Inventory Report submenu.  

In the dialog box that appears (Screen 10.1.2), select year 1995 and parameter 5-day BOD, and enter the 
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title 5-Day BOD Point Sources.  

Click to continue.  

Click to accept the default directory where all report files will be saved. The report files pcs.* are saved 
at the \Basins\WcReport\Catalogi\Reports\ directory.  

 

Generated Report 

The generated report includes two tables and a map layout. The first table, “Point Source Inventory - 
Summary by subwatershed” (Screen 10.1.3), provides a complete list of all discharge facilities within the 
watershed(s) and pertinent information such as location (city, subwatershed, and reach number), status 
(major vs. minor facility), and Standard Industrial Classification (SIC) number.  The second table, “Point 
Source Load - Summary by subwatershed,” provides the list of discharge facilities that actually 
discharged the selected pollutant for the given year (Screen 10.1.4).  
 
 

  
 Screen 10.1.3  
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 Screen 10.1.4 

The map layout shows the locations of all discharge facilities within the watershed(s) (Screen 10.1.5). 
Different map symbols are used to distinguish the facilities that discharged the selected pollutant for the 
given year from those facilities that did not. The Reach File network is also drawn in the map for 
reference purposes. A map inset is included to show the general location of the selected watershed(s) 
relative to the EPA regional boundary.  
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 Screen 10.1.5 

When the map layout is active, it can be printed through the Print submenu under the File main menu.  
Another way to print the map layout is through the Print button in the Project Window with the Layouts 
component selected and the “Point Source Map Layout” layout highlighted. 

The print function that ArcView provides for the tables is intentionally deactivated in BASINS.  Since 
this ArcView print function does not provide any formatting options, it fails to generate an acceptable 
printout of the BASINS tables, particularly when the tables are large. It is recommended that you import 
the content of the tables using a word processor. 

 

 

Tip: The subwatershed ID listed in the reports corresponds to the unique ID number automatically 
assigned to the subwatershed by the delineation tool or watershed boundary import utility.  The 
subwatershed ID corresponds to a cataloging unit number (eg. 05010007) if the report generator 
was run using the cataloging unit theme or an RF1 or RF3 segment ID for user delineated or 
imported watershed boundary themes (eg. RF1 = 05010007020 or RF3 = 5010007_035_4.93).  
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Tip: The files pcs.tx1 and pcs.tx2, which contain the tables, and pcs.wmf, which contains the point 
source map, are located in the \Basins\WcReport\<StudyArea>\Reports\ directory.  The 
<StudyArea> is the user-defined name or identifier given to the study area. It corresponds to the 
name in the View Table of Contents given to the theme that contains the boundary information of 
the study area.  

 



 10 Watershed Characterization Reports 

 271 

10.2 Water Quality Summary Report 

 
Purpose 

Water Quality Summary Report provides a summary of water quality monitoring stations within the 
selected watershed that monitored a particular pollutant during a given time period. The water quality data 
are presented as statistical summaries of the mean and selected percentiles of the observed data. The data 
were originally obtained from USEPA’s Storage and Retrieval System (STORET). The information 
generated in this report is summarized in table format and, if selected, in a map format. 

Application 

The Water Quality Summary Report generates information for characterizing water quality conditions of 
water bodies within a given watershed and can be used to support various watershed assessment and 
evaluation programs. Potential applications include review of existing monitoring programs, evaluation of 
ongoing monitoring activities, location of key stations with sufficient and relevant monitoring data for 
model calibration, and evaluation of data gaps. Although the information is summarized statistically, it 
can provide basic information to assess the conditions of a given water body, as well as to evaluate its 
changes over time. 

Before you Get Started 

First, verify that the “Reports without Spatial Analyst” extension is active in your BASINS project by 
typing Ctrl+B from the BASINS view and selecting the Reports item from the Extension Categories 
dropdown list.  The “Reports without Spatial Analyst” entry in the Basins Extensions list should be 
visible and selected.  If the “Reports without Spatial Analyst” is not selected (checked), click on it to 
select it. 

Key Procedures 

• Activate the watershed boundary theme 

• Select the watersheds for which the report will be generated 

• Under the Report main menu, select the Water Quality Summary Report submenu 

• Select the time period, pollutant, and map option in the dialog boxProcedures 

 

Operation Steps In the BASINS View table of contents (Screen 10.2.1), click the name of the appropriate 
watershed boundary theme to make it active.  The watershed boundary theme can be the cataloging unit 
boundary theme or a user delineated watershed boundary theme.  
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 Screen 10.2.1 

Activate the Select Feature tool and select (by clicking or dragging a box) the watershed for which the 
Water Quality Summary Report will be generated. Under the Report main menu, select the Water Quality 
Summary Report submenu. In the dialog (Screen 10.2.2) that appears, select the time period(s) from the 
check boxes and monitoring (pollutant) parameter from the list box provided in the dialog. Several time 
periods can be checked at one time. Click the check box if a location map of water quality monitoring 
stations is to be generated. You may choose to enter the map title in the text box provided.  
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 Screen 10.2.2 

Click to generate the report; otherwise, click Cancel to quit the tool without generating the report. 

 

TUTORIAL:  

Click the theme Cataloging Unit Boundaries to make it active.  

Check its check box to display the boundary theme in the View Window.  

Check the check box of the theme Water Quality Station to display the location of the water quality 
stations.  

Using the Select Feature tool, select watershed 05010007. Your BASINS screen should now look like 
Screen 10.2.1. If necessary, zoom to the study area using the Zoom to Selected Theme tool.  

Assign a value of 20 to “Hilltop Zone”, 10 to “Hilltop Classification Interval”, 20 to “Valley Zone”, and 
10 to “Valley Classification Interval”. Select the Red Monochromatic color scheme. Click OK. Note that 
the entire DEM 05010007 theme is reclassified to better represent your selected area.  
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Under the Report main menu, select the Water Quality Summary Report submenu.  

In the dialog box that appears (Screen 10.2.2), select the time periods 1975-1979 and 1985-1989 and the 
parameter Dissolved Oxygen, and enter the title Dissolved Oxygen.  

Click to continue.  

Click to accept the default directory where all report files will be saved. The report files wq.* are saved at 
the \Basins\WcReport\Catalogi\Reports\ directory.  

 

Generated Report 

The generated report includes several tables and a map layout. The first table, “Water Quality Station 
Inventory - Summary by Subwatershed” (Screen 10.2.3), provides a complete list of all water quality 
monitoring stations within the watershed(s) and pertinent information such as county location, river basin, 
and reach location. Not all of the water quality stations listed in the table might actually have monitored 
the selected pollutant for the given time period. The second set of tables, “Water Quality Summary - by 
Station” (Screen 10.2.4), contain the water quality stations that actually monitored the selected pollutant 
for the given time period(s). Each table is associated with a different water quality station and shows the 
statistics of the observed data for each time period selected.  
 
 

  
 Screen 10.2.3 
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The map layout shows the locations of all water quality monitoring stations within the watershed(s) 
(Screen 10.2.5). Different map symbols are used to distinguish the facilities that monitored the selected 
pollutant for the given time period from those facilities that did not. The Reach File network is also drawn 
in the map for reference purposes. A map inset is included to show the general location of the selected 
watershed(s) relative to the EPA regional boundary. 

When the map layout is active, it can be printed through the Print submenu under the File main menu. 
The print function that ArcView provides for the tables is intentionally deactivated in BASINS. Since this 
ArcView print function does not provide any formatting options, it fails to generate an acceptable printout 
of the BASINS tables, particularly when the tables are large. It is recommended that you import the 
content of the tables using a word processor.  
 
 

  
 Screen 10.2.4  
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 Screen 10.2.5 

The tables and the map are developed for the purpose of integrating them into a single document. A 
standard word processor can be used to import both the tables and the map for further editing and 
formatting. 

 

Tip: The files wq.tx1 and wq.tx2, which contain the tables, and wq.wmf, which contains the location 
map of the water quality stations, are located in the \Basins\WcReport\<StudyArea>\Reports\ 
directory. The <StudyArea> is the user-defined name or identifier given to the study area. It 
corresponds to the name in the View Table of Contents given to the theme that contains the 
boundary information of the study area.  
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10.3 Toxic Air Emission Report 

 
Purpose 

Toxic Air Emission Report provides a summary of facilities that are part of the Toxic Release Inventory 
(TRI) and have estimated air releases of a particular pollutant in a selected watershed. 

Application 

Information generated in Toxic Air Emission Report can be used to support the characterization of 
emission sources in a given watershed. It generates tabular summaries of TRI facilities with their 
corresponding estimates of pollutant air releases and other pertinent information such as facility 
identification name, city location, status (active or inactive facility), ownership type (government, 
commercial), and SIC code number. Together with other reports generated in BASINS, such as point 
source discharges, land use distribution, and water quality summary, this report can support analysis of 
the relative magnitude of air emissions in the overall watershed loading. This report also generates a map 
showing the location of the TRI facilities overlaid with the Reach File network and the boundary of the 
selected watershed. 

Before you Get Started 

First, verify that the “Reports without Spatial Analyst” extension is active in your BASINS project by 
typing Ctrl+B from the BASINS view and selecting the Reports item from the Extension Categories 
dropdown list.  The “Reports without Spatial Analyst” entry in the Basins Extensions list should be 
visible and selected.  If the “Reports without Spatial Analyst” is not selected (checked), click on it to 
select it. 

Key Procedures 

• Activate the watershed boundary theme 

• Select the watersheds for which the report will be generated 

• Under the Report main menu, select the Toxic Air Emission Report submenu 

• Select the toxic release year, pollutant type, and the map option in the dialog box 

 

Operation Steps In the BASINS View table of contents (Screen 10.3.1), click the name of the appropriate 
watershed boundary theme to make it active.  The watershed boundary theme can be the cataloging unit 
boundary theme or a user delineated watershed boundary theme.  
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 Screen 10.3.1 

Activate the Select Feature tool and select (by clicking or dragging a box) the watershed(s) for which the 
Toxic Air Emission Report will be generated. Under the Report main menu, select the Toxic Air Emission 
Report submenu. In the dialog box that appears (Figure 10.3.2), select the toxic release year and 
monitoring (pollutant) parameter in the list boxes provided. Click the check box if a location map of TRI 
facilities is to be generated. You may choose to enter the map title in the text box provided.  
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 Screen 10.3.2 

Click  to generate the report; otherwise, click Cancel to quit the tool without generating the report. 

 

TUTORIAL:  

Click the theme Cataloging Unit Boundaries to make it active.  

Check its check box to display the boundary theme in the View window.  

Check the check box of the theme Toxic Release Inventory to display the location of the TRI facilities. 
Using the Select Feature tool, select watershed 05010007. Your BASINS screen should now look like 
Screen 10.3.1. If necessary, zoom to the study area using the Zoom to Selected Theme tool.  

Under the Report main menu, select Toxic Air Emission Report submenu.  

In the dialog box that appears (Screen 10.3.2), select the year 1992 and parameter Zinc (Fumes and Dust), 
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and enter the title Zinc (Fumes and Dust) Air Emission.  

Click to continue.  

Click to accept the default directory where all report files will be saved. The report files tri.* are saved at 
the \Basins\WcReport\Catalogi\Reports\ directory.  

 

Generated Report 

The generated report includes two tables and a map layout. The first table, “Toxic Air Inventory - 
Summary by subwatershed” (Screen 10.3.3), provides a complete list of all TRI facilities within the 
watershed(s) and pertinent information such as city location, status (active or inactive facility), type of 
ownership (government, commercial), and Standard Industrial Classification number. The second table, 
“Toxic Air Emission - Summary by subwatershed” (Screen 10.3.4), provides the list of TRI facilities that 
actually released the selected pollutant for the given year. The air releases are grouped into two types, 
stack and fugitive emissions. Stack emissions include releases that occur through stacks, vents, ducts, 
pipes, or other confined air streams, as well as storage tank emissions and air releases from air pollution 
control equipment. Fugitive emissions include equipment leaks from valves, pump seals, flanges, 
compressors, sampling connections, and open ended lines; evaporative losses from surface impoundments 
and spills; and releases from building ventilation systems.  
 
 

  
 Screen 10.3.3 
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The map layout shows the location of all TRI facilities within the watershed(s) (Screen 10.3.5). Different 
map symbols are used to distinguish the facilities that released the selected pollutant for the given year 
from those facilities that did not. The Reach File network is also drawn in the map for reference purposes. 
A map inset is included to show the general location of the selected watershed(s) relative to the EPA 
regional boundary. 

When the map layout is active, it can be printed through the Print submenu under the File main menu. 
Another way to print the Toxic Air Emission map layout is through the Print button in the Project 
Window with the Layouts component selected and the “Toxic Air Emission Layout” layout highlighted. 

The print function that ArcView provides for the tables is intentionally deactivated in BASINS.  Since 
this  ArcView print function does not provide any formatting options, it fails to generate an acceptable 
printout of the BASINS tables, particularly when the tables are large. It is recommended that you import 
the content of the tables using a word processor.  
 
 

  
 Screen 10.3.4  
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 Screen 10.3.5 

 

Tip: The files tri.tx1 and tri.tx2, which contain the tables, and tri.wmf, which contains the location map 
of the TRI facilities, are located in the \Basins\WcReport\<StudyArea>\Reports\ directory. The 
<StudyArea> is the user-defined name or identifier given to the study area. It corresponds to the 
name in the View Table of Contents given to the theme that contains the boundary information of 
the study area.  
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10.4 Land Use Distribution Report 

 
Purpose 

Landuse Distribution Report provides a summary of the land use distribution within the selected 
watershed(s). The BASINS default land use data were originally obtained from the USGS Geographic 
Information Retrieval and Analysis System (GIRAS) and use the Anderson Level II classification. The 
information generated in this report is summarized in both table and map layout formats. 

Application 

Landuse Distribution Report can be used to examine the various land uses in the study area (by 
subwatershed) to assist in developing a modeling strategy such as the selection of nonpoint source 
segments (subwatershed) and the land use classes to be represented in the nonpoint source model. It can 
also be used to assess the need for a nonpoint source monitoring program and to determine areas where 
monitoring data are most useful for model parameterization and calibration. The report generates two 
tables. The first table is a tabular summary of the total acreage under each land use category (Anderson 
Level I classification). The second table provides the breakdown of the land use distribution in more 
detail using the Anderson Level II classification. The report also generates a map showing the land 
distribution within the watershed overlaid with the Reach File network and the boundary of the selected 
watershed. 

Before you Get Started 

First, verify that the “Reports without Spatial Analyst” extension is active in your BASINS project by 
typing Ctrl+B from the BASINS view and selecting the Reports item from the Extension Categories 
dropdown list.  The “Reports without Spatial Analyst” entry in the Basins Extensions list should be 
visible and selected.  If the “Reports without Spatial Analyst” is not selected (checked), click on it to 
select it. 

Key Procedures 

• Activate the watershed boundary theme 

• Select the watersheds for which the report will be generated 

• Under the Report main menu, select the Landuse Distribution submenu 

 

Operation Steps In the BASINS View table of contents (Screen 10.4.1), click the name of the appropriate 
watershed boundary theme to make it active.  The watershed boundary theme can be the cataloging unit 
boundary theme or a user delineated watershed boundary theme.  
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 Screen 10.4.1 

Activate the Select Feature tool and select (by clicking or dragging a box) the watershed for which the 
Land Use Distribution Report will be generated. Under the Report main menu, select the Land Use 
Distribution Report submenu. In the dialog box that appears, enter the land use map title. Click to 
generate the report; otherwise, click Cancel to quit the tool without generating the report.   

TUTORIAL:  

Click the theme Watershed.shp to make it active. This demonstrates that the report tools can also be 
applied to user-delineated watersheds.  

Check its Check Box to display the boundary theme in the View Window.  

Using the Select Feature tool, select the three delineated subwatersheds. Your BASINS screen should 
now look like Screen 10.4.1. If necessary, zoom to the study area using the Zoom to Selected Theme tool.  

Under the Report main menu, select Land Use Distribution Report submenu.  



 10 Watershed Characterization Reports 

 285 

In the dialog box that appears, enter the title “Land Use Distribution”.  

Click to continue.  

Click to accept the default directory where all report files will be saved. The report files landuse.* are 
saved at the \Basins\WcReport\Watershe\Reports\ directory.  

 

Generated Report 

The generated report includes two tables and a map layout. The first table, “Land Use Information - 
Summary by Major Land Use Category” (Screen 10.4.2), contains the total acreage under major land use 
category. The second table, “Land Use Information - Summary” (Screen 10.4.3), contains the acreage 
under more detailed land use classification.  
 
 

  
 Screen 10.4.2  
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 Screen 10.4.3 

The map layout, “Land Use Map Layout” (Screen 10.4.4), shows the land use distribution using the major 
land use categories. The Reach File network is also drawn in the map layout for reference purposes. A 
map inset is included to show the general location of the selected watershed(s) relative to the EPA 
regional boundary. 

When the map layout is active, it can be printed through the Print submenu under the File main menu. 
The map can also be imported into a document using a word processor. 

The print function that ArcView provides for the tables is intentionally deactivated in BASINS. Since this 
AcrView print function does not provide any formatting options, it fails to generated an acceptable 
printout for the BASINS tables, particularly when the tables are large. It is recommended that you import 
the content of the tables using a word processor. 

 

Tip: The files landuse.tx1 and landuse.tx2, which contain the tables, and landuse.wmf, which contains 
the land use map, are located in the \Basins\WcReort\<StudyArea>\Reports\directory. The 
<StudyArea> is the user-defined name or identifier given to the study area. It corresponds to the 
name in the View Table of Contents given to the theme that contains the boundary information of 
the study area.  
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 Screen 10.4.5 
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10.5 State Soil Characteristic Report 

 
Purpose 

State Soil Characteristic Report provides a summary of the spatial variability of selected soil parameters 
within one or a set of subwatersheds. The soil parameters considered include water table depth, bedrock 
depth, soil erodibility, available water capacity, permeability, bulk density, pH, organic matter content, 
soil liquid limit, soil plasticity, percent clay content, and percent silt and clay content. The data were 
originally obtained from the U.S. Department of Agriculture (USDA) Natural Resources Conservation 
Service (NRCS) State Soil and Geographic Database (STATSGO). The information generated in this 
report is summarized in table format and, if selected, presented in map format. 

Application 

State Soil Characteristic Report is a useful tool for characterizing the spatial variability of soil within the 
selected watershed(s). The soil data were originally obtained from the STATSGO database, which breaks 
down an area coverage into smaller georeferenced units called map units. Each map unit is further broken 
down into soil components and layers. 

Soil parameter values are calculated by STATSGO map units and by subwatershed through a combination 
of aggregation methods such as area-weighting and depth integration. The parameter value for a particular 
map unit can also be selected so that it corresponds to the value of the largest soil component within the 
map unit (e.g., mode method) and/or to the value of the soil surface layer. The calculation can be based on 
the minimum, maximum, or mean values of the soil parameters available in the STATSGO database. 

The soil report generates a table of aggregated values of the selected parameter by STATSGO map unit 
and by subwatershed. It also generates maps showing the spatial variability of the selected soil parameter 
by map unit and by subwatershed overlaid with the Reach File network (RF1) and the boundary of the 
selected watershed. 

Key Procedures 

• Activate the watershed boundary theme 

• Select the watersheds for which the report will be generated 

• Under the Report main menu, select the State Soil Characteristic Report submenu 

• Select the soil parameter, type of estimate, aggregation method, and map option in the dialog box 

 

Before you Get Started 

First, verify that the “Reports without Spatial Analyst” extension is active in your BASINS project by 
typing Ctrl+B from the BASINS view and selecting the Reports item from the Extension Categories 
dropdown list.  The “Reports without Spatial Analyst” entry in the Basins Extensions list should be 
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visible and selected.  If the “Reports without Spatial Analyst” is not selected (checked), click on it to 
select it. 

Operation Steps In the BASINS View table of contents (Screen 10.5.1), click the name of the watershed 
boundary theme to make it active.  The watershed boundary theme can be the cataloging unit boundary 
theme or a user delineated watershed boundary theme.  
 
 

  
 Screen 10.5.1 

Activate the Select Feature tool and select (by clicking or dragging a box) the watershed(s) for which the 
soil report will be generated. Under the Report main menu, select the State Soil Characteristic Report 
submenu. In the dialog box that appears (Screen 10.5.2), select the soil parameter from the list box and 
the type of estimate, component aggregation method, and (if necessary) layer aggregation method through 
the check boxes. Click the check box if soil maps are to be generated. You may choose to enter the map 
title in the text box provided. 

For soil parameters that do not vary with depth, such as water table and bedrock depths, only soil 
component aggregation is required to obtain the “representative” values by map units. You may choose 
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the area-weighted method of aggregating the soil components within a map unit to obtain the 
“representative” value. On the other hand, you may choose the value of the largest soil component within 
the map unit as the “representative” value for the entire map unit.  
 
 

  
 Screen 10.5.2 

For the rest of the soil parameters that also vary with depth (soil layers) such as soil erodibility, available 
water capacity, permeability, bulk density, pH, organic matter content, soil liquid limit, soil plasticity, 
percent clay content, and percent silt and clay content, an extra step of layer aggregation is required to 
obtain a “representative” value for all soil layers. You may choose the depth-integration (depth-weighted) 
method of aggregating the soil layers of a particular soil component within the map unit. On the other 
hand, you may choose the value associated with the surface soil layer as the “representative” value for all 
soil layers. 

For the soil parameters supported in this report tool, the STATSGO database reports both minimum and 
maximum values. This provides the user an option of generating the soil characterization report based on 
minimum, maximum, or mean (of the minimum and maximum) values. Click to generate the report; 
otherwise, click Cancel to quit the tool without generating the report. 
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TUTORIAL:  

Click the theme Watershed.shp to make it active. This demonstrates that the report tools can also be 
applied to user-delineated watersheds.  

Check its check box to display the boundary theme in the View window.  

Using the Select Feature tool, select the three delineated subwatersheds. Your BASINS screen should 
now look like Screen 10.5.1. If necessary, zoom to the study area using the Zoom to Selected Theme tool.  

Under the Report main menu, select the State Soil Characteristic Report submenu.  

In the dialog box that appears (Screen 10.5.2), select Parameter Permeability and Options Mean, Area-
Weighted and Depth-Integration.  

Enter the title “Soil Permeability”.  

Click to continue.  

Click to accept the default directory where all report files will be saved. The report files soil.* are saved 
at the \Basins\WcReport\Watershe\Reports\ directory.  

 

Generated Report 

The generated report includes two tables and two map layouts. The first table, “State Soil Report - 
Summary by subwatershed” (Screen 10.5.3), contains the acreage of the STATSGO map unit and the 
corresponding aggregated values of the selected parameter. The second table, “State Soil Statistics - 
Summary by subwatershed” (Screen 10.5.4), contains the total acreage of the subwatershed and the mean, 
maximum, and minimum of the map unit values within the subwatershed.  
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 Screen 10.5.3  
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 Screen 10.5.4 

The first map layout (State Soil Map Layout 1) shows the spatial distribution of the selected soil 
parameter by watershed in which one value is assigned for each subwatershed (Screen 10.5.5). The 
second map layout, “State Soil Map Layout 2,” shows the spatial distribution of the selected soil 
parameter by STATSGO map unit (Screen 10.5.6). On both maps, the Reach File network is also drawn 
for reference purposes. A map inset is included to show the general location of the selected watershed(s) 
relative to the EPA regional boundary.  
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 Screen 10.5.5  
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 Screen 10.5.6 

When the map layout is active, it can be printed through the Print submenu under the File main menu. 
The map layout can be activated by clicking on it. Another way to print the map layout is through the 
Print button in the Project Window with the Layouts component selected and the “State Soil Map Layout 
#” layout highlighted. 

The print function that ArcView provides for the tables is intentionally deactivated in BASINS. Since this 
ArcView print function does not provide any formatting options, it fails to generate a good printout of the 
BASINS tables, particularly when the tables are large. It is recommended that you use a word processor 
to import both the tables and maps for printing, further editing and formatting, or incorporation into other 
documents. 

 

Tip: The files soil.tx1 and soil.tx2, which contain the tables, and soil.wmf, which contains the soil 
map, are located in the \Basins\WcReport\<StudyArea>\Reports\ directory. The <StudyArea> is 
the user-defined name or identifier given to the study area. It corresponds to the name in the View 
Table of Contents given to the theme that contains the boundary information of the study area.  
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10.6 Watershed Topographic Report 

 
Purpose 

Watershed Topographic Report provides a statistical summary and distribution of discrete land surface 
elevations in the watershed. It also generates an elevation map of the selected watershed. The default 
source elevation map in BASINS is derived from the conversion of the USGS one degree Digital 
Elevation Map (DEM) into a vector map product. The information generated in this report is summarized 
in table format and, if selected, in map format. 

Application 

Watershed Topographic Report is a useful tool for characterizing the magnitudes and distribution of 
elevations in the watershed. Statistical measures of elevation such as minimum, maximum, mean, median, 
and standard deviation are provided. A graph showing the cumulative percentage of the total area under a 
particular elevation is generated (hypsometric curve). This information can be used to quickly evaluate 
the relative “steepness” of the watershed compared to that of other watersheds and to correlate it with the 
results of water quality modeling. In conjunction with the Reach File data, the DEM data can be used to 
assist users in delineating watersheds more accurately. Using the Identify tool, the user can determine the 
elevation at key locations such as the headwaters of a stream. The hypsometric curve provides an overall 
description of the elevation in the watershed and consequently can assist in defining key topographic 
parameters generally required for water quality and nonpoint source modeling. 

Before you Get Started 

First, verify that the “Reports without Spatial Analyst” extension is active in your BASINS project by 
typing Ctrl+B from the BASINS view and selecting the Reports item from the Extension Categories 
dropdown list.  The “Reports without Spatial Analyst” entry in the Basins Extensions list should be 
visible and selected.  If the “Reports without Spatial Analyst” is not selected (checked), click on it to 
select it. 

Key Procedures 

• Activate the watershed boundary theme 

• Select the watersheds for which the report will be generated 

• Under the Report main menu, select the Watershed Topographic Report submenu 

 

Operation Steps In BASINS View’s Table of Contents (Screen 10.6.1), click the name of the watershed 
boundary theme to make it active.  The watershed boundary theme can be the cataloging unit boundary 
theme or a user delineated watershed boundary theme.  
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 Screen 10.6.1 

Activate the Select Feature tool and select (by clicking or dragging a box) the watershed(s) for which the 
land use report will be generated. Under the Report main menu, select the Watershed Topographic Report 
submenu. In the text box that appears, enter the map title. Click to generate the report; otherwise, click 
Cancel. 

 

Tip: The BASINS DEM data layer is tiled by watershed (8-digit cataloging unit). Due to the size of 
each watershed DEM file, it is recommended that you import only the needed files. Refer to 
Section 7.2 for instructions on how to import DEM files.  

 

 

Tip: The DEM theme for the selected watershed should be available. Since DEM is not a part of the 
BASINS core data, it has to be imported manually. Default BASINS DEM data that came with 
the extracted data are stored in \BASINS\Data\<User-Specified Data Directory>\Dem\. The 
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<User-Specified Data Directory> is the directory where the BASINS extracted data are stored, 
and it was specified during data extraction.  

 

 

TUTORIAL:  

Click the theme Watershed.shp to make it active. This demonstrates that the report tools can also be 
applied to user-delineated watersheds.  

Check its check box to display the boundary theme in the View Window.  

Using the Select Feature tool, select the three delineated subwatersheds. Your BASINS screen should 
now look like Screen 10.6.1. If necessary, zoom to the study area using the Zoom to Selected Theme tool. 
This requires that the DEM data for the particular selected subwatersheds have been imported into the 
BASINS View already.  

Under the Report main menu, select the Watershed Topographic Report submenu.  

In the dialog box that appears, enter the title “Land Surface Elevation”.  

Click to continue.  

Click to accept the default directory where all report files will be saved. The report files dem.* are saved 
at the \Basins\WcReport\Watershe\Reports\ directory.  

 

Generated Report 

The generated report includes a table, chart, and map layout. The table, “Elevation Report” contains the 
summary statistics of the land surface elevations in the watershed (Screen 10.6.2). It also shows the 
percent distribution of the total watershed area under a particular elevation. This distribution is plotted in 
the chart component of the report (Screen 10.6.3). The map layout shows the land surface elevation map 
in the watershed (Screen 10.6.4). The Reach File network is also drawn for reference purposes. A map 
inset is included to show the general location of the selected watershed(s) relative to the EPA regional 
boundary. 

When the map layout is active, it can be printed through the Print submenu under the File main menu. 
The map layout can be activated by clicking on it. Another way to print the map layout is through the 
Print button in the Project Window with the Layouts component selected and the “Elevation Map” layout 
highlighted. 

The print function that ArcView provides for the tables is intentionally deactivated in BASINS. Since this 
ArcView print function does not provide any formatting options, it fails to generate a good printout of the 
BASINS tables, particularly when the tables are large. It is recommended that you use a word processor 
to import both the tables and maps for printing, further editing and formatting, or incorporation into other 
documents. 
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Tip: The file dem.txt, which contains the table, and dem.wmf, which contains the elevation map, are 
located in the \Basins\WcReport\<Study Area>\Reports\ directory. The <Study Area> is the user-
defined name or identifier given to the study area. It corresponds to the name in the View Table of 
Contents given to the theme that contains the boundary information of the study area.  

  
 

   
 Screen 10.6.2  
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 Screen 10.6.3  
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 Screen 10.6.4 
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10.7 Land Use Distribution Report (Grid) 

 
Purpose 

Landuse Distribution Report (Grid) provides a summary of the land use distribution within the selected 
watershed(s). The new Multi Resolution Land Cover (MRLC) data (grid based) can be used to generate 
the landuse distribution report. The information generated in this report is summarized in both table and 
map layout formats. 

Application 

Landuse Distribution Report (Grid) can be used to examine the various land uses in the study area (by 
subwatershed) to assist in developing a modeling strategy such as the selection of nonpoint source 
segments (subwatershed) and the land use classes to be represented in the nonpoint source model. It can 
also be used to assess the need for a nonpoint source monitoring program and to determine areas where 
monitoring data are most useful for model parameterization and calibration. This report requires the 
ArcView Spatial Analyst extension.  A report showing all the landuse distribution for the required 
watershed by major land use category is generated.  A map showing the land distribution within the 
watershed overlaid with the Reach File network and the boundary of the selected watershed is also 
generated. 

Key Procedures 

• Select the BASINS extensions submenu under the File menu 

• Select Report as the extension category and check the Reports with Spatial analyst extension 

• Import the Grid theme using the Add Theme (Grid) BASINS extension 

• Activate the watershed boundary theme 

• Select the watersheds for which the report will be generated 

• Under the Report main menu, select the Landuse (Grid) submenu 

 

Operation Steps With BASINS View active, select the Basins Extensions... menu under the File menu 
(Screen 10.7.1).  
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 Screen 10.7.1 

A “BASINS Extension Manager” dialog box will open. Select “Reports” under “Select Extension 
Category”. Click Report with Spatial Analyst as the BASINS extension (Screen 10.7.2). A short 
description of the extension is provided at the bottom of the dialog box.  Similarly click on the Add 
Theme (Grid) extension under Data extension category (Screen 10.7.3). Click on OK when done.  Note 
this will add a Landuse (Grid) submenu to the Reports menu and a Add Theme (Grid) submenu under the 
Data menu.  
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 Screen 10.7.2  
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 Screen 10.7.3 

Select the Add Theme (Grid) submenu under the Data menu to import the required grid theme (Screen 
10.7.4).  
 

   
 Screen 10.7.4 

Select “Landuse” from the Add Theme message box (Screen 10.7.5)  
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 Screen 10.7.5 

Select the shape file to be imported (Screen 10.7.6).  Note the landuse GRID files can be stored in any 
directory.  For demonstration purposes, the Tutorial data set is provided with the MRLC data under 
\BASINS\DATA\&LTProject name&GT\GRIDS\MRLC.  The users will need to provide the MRLC data 
for thier watershed(s) before they can use this option.  
 

   
 Screen 10.7.6 

In the BASINS View table of contents (Screen 10.7.7), click the name of the appropriate watershed 
boundary theme to make it active.  The watershed boundary theme can be the cataloging unit boundary 
theme or a user delineated watershed boundary theme.  You may display the landuse GRID theme to 
ensure that it completly covers the watershed(s). Activate the Select Feature tool and select (by clicking 
or dragging a box) the watershed for which the Grid based Land Use Distribution Report will be 
generated (Screen 10.7.7)  
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 Screen 10.7.7 

Under the Report main menu, select the Landuse (Grid) submenu (Screen 10.7.8). In the dialog box that 
appears, enter the directory name under which the report will be stored for the study area (Screen 10.7.9).  
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 Screen 10.7.8  
 

   
 Screen 10.7.9 

Select “User Grid Landuse” as the landuse type to report (Screen 10.7.10)  
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 Screen 10.7.10 

Click OK to generate the report.  A new theme is generated with the landuse distribution for the selected 
watershed (Screen 10.7.11)  
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 Screen 10.7.11 

 

Generated Report 

The generated report includes a table and a map layout. The table, “Land Use Distribution by Major Land 
Use Category” (Screen 10.7.12), contains the total acreage under major land use category.  
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 Screen 10.7.12 

The map layout, “Land Use” Map Layout (Screen 10.7.13), shows the land use distribution using the 
major land use categories. The Reach File network is also drawn in the map layout for reference purposes. 
A map inset is included to show the general location of the selected watershed(s) relative to the EPA 
regional boundary.  
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 Screen 10.7.13 

When the map layout is active, it can be printed through the Print submenu under the File main menu. 
The map can also be imported into a document using a word processor. 

The print function that ArcView provides for the tables is intentionally deactivated in BASINS. Since this 
AcrView print function does not provide any formatting options, it fails to generate an acceptable printout 
for the BASINS tables, particularly when the tables are large. It is recommended that you import the 
content of the tables using a word processor. 

 

Tip: The layout and all the temporary files that are used to generate the layout and table are located in 
the \Basins\WcReport\&LTDirectoryName&GT\ where the DirectoryName is the name given 
during the report generation process.  
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10.8 Watershed Topographic Report (Grid) 

 
Purpose 

Watershed Topographic Report (Grid) provides a statistical summary and distribution of discrete land 
surface elevations in the watershed. It also generates an elevation map of the selected watershed. The 
source elevation map in BASINS is a Grid based DEM.  The information generated in this report is 
summarized in table, chart and in map formats. 

Application 

Watershed Topographic Report (Grid) is a useful tool for characterizing the magnitudes and distribution 
of elevations in the watershed. Statistical measures of elevation such as minimum, maximum, mean, 
median, and standard deviation are provided. A graph showing the cumulative percentage of the total area 
under a particular elevation is generated (hypsometric curve). This information can be used to quickly 
evaluate the relative “steepness” of the watershed compared to that of other watersheds and to correlate it 
with the results of water quality modeling. The hypsometric curve provides an overall description of the 
elevation in the watershed and consequently can assist in defining key topographic parameters generally 
required for water quality and nonpoint source modeling.  This report requires the ArcView Spatial 
Analyst Extension. 

Key Procedures 

• Select the BASINS extensions submenu under the File menu 

• Select Report as the extension category and check the Reports with Spatial analyst extension 

• Import the Grid theme using the Add theme(Grid) 

• Activate the watershed boundary theme 

• Select the watersheds for which the report will be generated 

• Under the Report main menu, select the Topography (Grid) submenu 

 

Operation Steps With BASINS View active follow step 1 and step 2 as given in Section 10.7.  A 
Topography (Grid) sub menu will be added to the Report menu and a Add Theme (Grid) submenu under 
the Data menu. 

Select the Add Theme (Grid) submenu under the Data menu to import the required grid theme (Screen 
10.8.1).  
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 Screen 10.8.1 

Select “DEM Grid” from the Add Theme message box (Screen 10.8.2)  
 

   
 Screen 10.8.2 

Select the shape file to be imported (Screen 10.8.3).  Note the DEM grid files are stored under 
\BASINS\DATA\&LTProject name&GT\GRIDS\DEM.  Higher resolution DEM grid data (eg. 24K) can 
be used.  
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 Screen 10.8.3 

In the BASINS View table of contents (Screen 10.8.4), click the name of the appropriate watershed 
boundary theme to make it active.  The watershed boundary theme can be the cataloging unit boundary 
theme or a user delineated watershed boundary theme.  Make sure the imported DEM GRID theme is also 
active. Activate the Select Feature tool and select (by clicking or dragging a box) the watershed for which 
the Grid based Topography Distribution Report will be generated (Screen 10.8.4).  You may display the 
DEM grid theme to ensure that it completly covers the watershed.  
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 Screen 10.8.4 

Under the Report main menu, select the Topography (Grid) submenu (Screen 10.8.5). In the text box that 
appears, enter the map title (Screen 10.8.6).  A Report Generator warning message box will appear 
(Screen 10.8.7).  The message describes the computational intensive nature of this operation. Click on OK 
after reading the message.  
 

   
 Screen 10.8.5  
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 Screen 10.8.6 

 
 

   
 Screen 10.8.7 

A message box will appear asking whether to proceed with the report generation process or not.  Click on 
OK to generate the report; otherwise, click Cancel to abort (Screen 10.8.8).  
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 Screen 10.8.8 

A Report generator message box will pop up asking the user to either create a new directory to store the 
report or use an existing directory (Screen 10.8.9).  On clicking No an input box will pop up, prompting 
the user to enter the name of the directory (Screen 10.8.10).  Clicking on Yes will start the report 
generation process right away and store the resulting report in the existing directory. Note upon 
completion of report generation process a new theme is created with the DEM elevation just for the 
selected watershed in addition to the report.  
 

   
 Screen 10.8.9  
 

   
 Screen 10.8.10 

 

Tip: The DEM theme for the selected watershed should be available. The DEM is not included in the 
project by default and has to be imported manually. Default BASINS DEM data that came with 
the extracted data are stored in \BASINS\Data\<User-Specified Data Directory>\GRIDS\DEM\. 
The <User-Specified Data Directory> is the directory where the BASINS extracted data are 
stored, and it was specified during data extraction.  
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Generated Report 

The generated report includes a table, chart, and map layout. The table, “Elevation Report” contains the 
summary statistics of the land surface elevations in the watershed (Screen 10.8.11). It also shows the 
percent distribution of the total watershed area under a particular elevation. This distribution is plotted in 
the chart component of the report (Screen 10.8.12). The map layout shows the land surface elevation map 
in the watershed (Screen 10.8.13). The Reach File network is also drawn for reference purposes. A map 
inset is included to show the general location of the selected watershed(s) relative to the EPA regional 
boundary. 

When the map layout is active, it can be printed through the Print submenu under the File main menu. 
The map layout can be activated by clicking on it. Another way to print the map layout is through the 
Print button in the Project Window with the Layouts component selected and the “Elevation Map” layout 
highlighted. 

The print function that ArcView provides for the tables is intentionally deactivated in BASINS. Since this 
ArcView print function does not provide any formatting options, it fails to generate a good printout of the 
BASINS tables, particularly when the tables are large. It is recommended that you use a word processor 
to import both the tables and maps for printing, further editing and formatting, or incorporation into other 
documents. 

Tip: The file dem.txt, which contains the table, and dem.wmf, which contains the elevation map, are 
located in the \Basins\WcReport\<Study Area>\Reports\ directory. The <Study Area> is the user-
defined name of the directory or identifier given to the study area.  

  

   
 Screen 10.8.11  
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 Screen 10.8.12  
 

   
 Screen 10.8.13 
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10.9 Lookup Tables 

 
Purpose 

The Lookup Tables provide users quick and easy access to important reference information such as the 
map projection, definitions of agency codes, Standard Industrial Classification (SIC) codes, and the water 
quality criteria and threshold values of a particular pollutant. 

Application 

The Lookup Tables provide four types of information: (1) water quality criteria and threshold values, (2) 
SIC codes and definitions, (3) STORET agency codes and definitions, and (4) the map projection of the 
map products in the current BASINS project file. 

The lookup table for the water quality criteria provides key threshold values that a user needs when 
applying TARGET at a regional scale or when examining water quality summary data at specific 
monitoring stations. 

The lookup table for the map projection of the data products in the current BASINS project file is useful 
for reference purposes, particularly when new data have to be added. For the new spatial data to be 
displayed in the same map extent as the existing data, the map projection parameters specified in the 
lookup table should be used during projection. 

The lookup table for the agency codes can be used as a reference to identify the source of monitoring data 
in BASINS. The lookup table for the SIC codes can be used as a reference to identify the industrial 
classification of a point source discharger. 

Key Procedures 

• Select the BASINS extensions submenu under the File menu 

• Select Reports as the extension category and check the Lookup extension 

• Water Quality Criteria and Threshold Values  
 - Under the Reports menu, select the Water Quality Criteria menu  
 - Select the pollutant in the dialog box to view the corresponding threshold values 
 

• Standard Industrial Classification Codes and Definitions 
 - Under the Reports menu, select the Standard Industrial Codes menu 
 - Select the search option (SIC Number or SIC Name) in the dialog box and select a specific SIC 
number (or name) to display the corresponding SIC name (or number) 
 

• STORET Codes and Definitions 
 - Under the Reports menu, select the STORET agency codes and definitions menu 
 - Select the STORET agency code in the dialog box to display the corresponding program name, 
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contact person, and telephone number 
 

• Map Projection Parameters 
 - Under the Reports menu, select the Projection Parameters menu 
 

 

Detailed Operations 

 

• With BASINS View active, select the Basins Extensions... menu under the File menu (Screen 10.9.1).  
 

   
 Screen 10.9.1 

 

• A “BASINS Extension Manager” dialog box will open. Select “Reports” under “Select Extension 
Category”. Click Lookup as the BASINS extension (Screen 10.9.2). A small description of the 
extension is provided at the bottom of the dialog box.  Click on Ok when done.  Note this will add 
four submenus under the Reports menu : 1) 304 a Water Quality Criteria 2) Standard Industrial 
Classification Codes 3) STORET Agency Codes and 4) Projection Parameters.  
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 Screen 10.9.2 

 

Water Quality Criteria and Threshold Values With BASINS View active (Screen 10.9.3), select the 
304 a Water Quality Criteria submenu under the Reports menu. Note that the lookup tables do not 
depend on what themes are active in the BASINS View window. In the scroll box of the dialog box that 
appears (Screen 10.9.3), select the monitoring parameter by clicking on its name. The threshold values 
associated with the selected pollutant parameter for six water quality criteria are displayed in the text box 
in the bottom half of the dialog box. Threshold values are displayed for freshwater acute and chronic, 
marine acute and chronic, and human health carcinogenic risk (recalculated values) for water and organic 
tissue. The Chemical Abstract Service (CAS) number and the STORET parameter code are also provided 
for the selected pollutant. Select as many parameters as needed. To quit the dialog box, click the X at the 
upper right corner of the dialog box.  
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Screen 10.9.3  
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 Screen 10.9.4 

Standard Industrial Classification Codes and Definitions With BASINS View active (Screen 10.9.3), 
select the Standard Industrial Codes submenu under the Reports menu. Note that the Lookup Tables do 
not depend on what themes are active in the BASINS View window. In the dialog box that appears 
(Screen 10.9.5), click the radio button associated with the preferred search option by SIC number or by 
name. Depending on the selected search option, select the SIC number or name in the scroll box by 
clicking on it to display the corresponding SIC name or number in the text box in the bottom half of the 
dialog box. The 1997 North American Industry Classification System (NAICS) code and name associated 
with the selected SIC number or name are also included in the display.  
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 Screen 10.9.5 

Select as many SIC names or numbers as needed. To quit the dialog box, click the X at the upper right 
corner of the dialog box. 

STORET Codes and Definitions With BASINS View active (Screen 10.9.3), select the STORET Agency 
Codes submenu under the Reports menu. Note that the Lookup Tables do not depend on what themes are 
active in the BASINS View window. In the scroll box of the dialog box that appears (Screen 10.9.6), 
select the STORET agency code. The corresponding program name, contact person, and telephone 
number are displayed in the bottom half of the dialog box.  
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 Screen 10.9.6 

Select as many STORET agency codes as needed. To quit the dialog box, click the X at the upper right 
corner of the dialog box. 

Map Projection Parameters With BASINS View active (Screen 10.9.3), select the Projection 
Parameters menu under the Reports menu. Note that the Lookup Tables do not depend on what themes 
are active in the BASINS View window. The projection parameters of the data products in the BASINS 
View of the current BASINS project file are shown in the text box that appears (Screen 10.9.7).  
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 Screen 10.9.7 

Click OK to quit the text box. 


